A Comprehensive Guide to Cascade
# Table of Contents

Start-to-Finish Guide ........................................................................................................ 4

1. Log into Cascade ........................................................................................................... 4

2. Navigating Cascade’s Main Screen ............................................................................. 5
   1. Tool Bar .................................................................................................................... 5
   2. Tabs ......................................................................................................................... 5
   3. Folder Tree .............................................................................................................. 5
   4. Messages ................................................................................................................ 5
   5. Recycle Bin ............................................................................................................. 6
   6. Main Window ......................................................................................................... 6

3. Edit a Page .................................................................................................................... 7
   a. Locate the Page ....................................................................................................... 7
   b. Edit Tab .................................................................................................................. 7
   c. Page Fields ............................................................................................................ 7
   d. WYSIWYG Editor .................................................................................................... 9
   e. Autosave Drafts ..................................................................................................... 14
   f. Submit .................................................................................................................... 14

4. Add a New Page ........................................................................................................... 15

5. Edit a Page .................................................................................................................... 15
   a. Upload an Image ..................................................................................................... 15
   b. Upload a File ......................................................................................................... 16
   c. Replace an Image or File ....................................................................................... 17
   d. Create a New Folder .............................................................................................. 18
   e. Edit Folder ............................................................................................................. 18
   f. Edit the Footer ....................................................................................................... 19
   g. Reorder Left-Hand Navigation .............................................................................. 19
   h. View Different Versions ....................................................................................... 20
   i. Publishing/Un-publishing ...................................................................................... 20
   j. Publish/Un-publish a Single page, File, or Image .................................................. 20
   k. Publish/Un-publish an Entire Folder and its Contents .......................................... 21
   l. Publish/Un-publish the Entire Website ................................................................... 21

6. Moving/Renaming within Cascade ............................................................................ 22
   a. Moving a Page, Folder, or File ............................................................................. 22
   b. Rename a Page, Folder, or File ............................................................................. 22
   c. Deleting a Page, Folder, or File ............................................................................ 23

A. Step-by-Step Quick Reference .................................................................................. 24
   1. Log into Cascade ................................................................................................... 24
   2. Edit a Page ............................................................................................................. 24
   3. Add a New Page .................................................................................................... 24
   4. Upload an Image or a File ..................................................................................... 25
   5. Create a new folder ............................................................................................... 25
   6. Reorder Navigation ............................................................................................... 26
   7. Edit the Footer ....................................................................................................... 26
   8. Publish/Un-publish a Single Page, File or Image .................................................. 26
   9. Publish/Un-publish an Entire Folder and its Contents .......................................... 27
  10. Publish/Un-publish the entire website ..................................................................... 27
11. **WYSIWYG Editor** ................................................................. 27
   a. Change text into a heading...........................................................27
   b. Creating a List..................................................................................28
   c. Adding a Link to an Internal Page.......................................................28
   d. Add a Link to a File (pdf, doc, etc.) on Your Site.................................28
   e. Add a Link to an Anchor (a Targeted Spot) on the Page.........................28
   f. Add an External Link........................................................................28
   g. Add an Email Link............................................................................29
   h. Add an Image..................................................................................29
   i. Add an Anchor................................................................................29
   j. Add a Table...................................................................................29
   k. Edit a Table..................................................................................30

B. **Best Practices for Web Writing** ......................................................31

C. **Best Practices for Headers** ..........................................................32

D. **Best Practices for Accessibility** .......................................................33

E. **Working with Tables** .................................................................34
   a. General Tab...................................................................................34
   b. Advanced tab................................................................................34
Start-to-Finish Guide

1. Log into Cascade
Go to http://www.northwestern.edu/cms for an easy way to access Cascade.

Locate and click the link labeled Cascade Server Login.

Use your NetID and Password to log into Cascade (See Figure 1). If you have forgotten either your NetID or your Password, please contact NUIT via phone at (847)-491-4357. You should now see the main Cascade screen.

Figure 1: Cascade uses NU Online Passport for login information.
2. Navigating Cascade’s Main Screen
There are specific areas within Cascade that you should become familiar with.

1. Tool Bar
Toward the top of the screen, you will see a blue bar. This is the main Tool Bar. You will frequently use the New button to create various elements in your website.

2. Tabs
Toward the top of the main window, various tabs are available. These tabs will change depending on which screen you are viewing. Generally speaking, any action you wish to perform (such as edit, view, or rename) will appear in the tabs area.

3. Folder Tree
The folder tree is the primary way to navigate within Cascade. The folder titled base folder contains everything on your website.

Tip: Use a page’s URL (or address) to determine which folder the page is in. Look for clues between each of the slashes.

4. Messages
Cascade has the ability to send you messages when a specific action is performed (see Figure 3). Typically, the only message displayed here is a Publish Message. When your page is published, it will go into a queue (similar to how you might print to an office printer). Once the page is published, you will see a confirmation message in this area.

Figure 2: Main screen with highlighted

Figure 3: Messages
5. Recycle Bin

When you delete items, they are automatically placed in the Recycle Bin (see Figure 4). Just as you can recover documents in your computer’s recycle bin, you can also recover pages or files that you may have deleted accidentally. Items will remain in the recycle bin for 15 days.

6. Main Window

This is the main window in Cascade (see Figure 5). Nearly all actions you perform in Cascade will take place in this area.
3. Edit a Page

It is simple to edit pages in Cascade. With the exception of your home page, you will use the same process to edit each page.

a. Locate the Page

As you may recall from the introduction, the address bar holds vital information for locating the page you wish to edit. A name between slashes indicates a folder. The name before the .html is a page name.

For example, consider the following page:

http://www.anthropology.northwestern.edu/about/index.html

The first name that appears after the site URL is /about/. Since it is surrounded by slashes, you will know that this is a folder named about. The last portion of the URL is index.html. Now you know that you must locate the index page.

In the folder tree, locate the folder titled /about. Click on the folder, then locate and click on index page.

b. Edit Tab

Toward the top of the main window, locate and click Edit (see Figure 7). The edit screen will load in the main window.

As you can see, the edit screen divides the page into a few different sections. Dividing the page helps to ensure that various sections in your template remain uniform.

c. Page Fields

We will examine the page's field in parts.

i. Inline Metadata

The Inline Metadata section determines how and where the page will display. Inline metadata powers the 'magic' of Cascade. Inline Metadata allows Web Communications to program your site so you only need to update a page name once.
• **Display Name**
  a. Typically a **Display Name** is a shortened version of the title. If you use a **Display Name**, it appears in navigation elements such as the top navigation and side navigation.
  
  b. As you can see, the **Display Name** is optional. If you leave this field blank, Cascade will use the title field in its place.

• **Title**
  The **Title** is the primary name for the page. The **Title** appears at the top of each page. The **Title** also appears in the title bar in your browser window (as illustrated in Figure 10).

![Figure 9: An example of the display name on a page](image)

**Tip:** What’s the difference between a Display Name and Title? The Display Name is a way to shorten a page name. The title is a way to display the entire name without disturbing the navigation. For example, *Frequently Asked Questions* may not fit into the navigation. In this example, create a display name *FAQ* and a title *Frequently Asked Questions*.

• **Display in Navigation**
  You have the choice to display the page in the navigation. By default, the option next to **Display in Navigation** is **yes**. If you would like to hide this page, change the option to **no**.
ii. **Web Page**

The **Web Page** area is the page’s main content (See Figure 11). You will spend the most time in this section when adding or editing pages in Cascade.

- **Page Content**
  
  The **Content** field is where you edit the text on the page. You will notice that the **Content** field looks similar to other word editing programs (such as Microsoft Word). In web editing, this is called a WYSIWYG (pronounced WIZ-zee-wig) editor. It stands for **What You See Is What You Get**.

### d. WYSIWYG Editor

Given that you will recognize many of the buttons used in the WYSIWYG editor, we will only go over a few that are unique to web editing.
Pasting Text
Some people find it convenient to use the button within the WYSIWYG editor to paste text into Cascade (see Figure 12, Item 1). Unfortunately, many browsers require reconfiguring your browser in order for this button to work. As a workaround, use your mouse or keyboard shortcuts. You may right-click your mouse on a PC or ctrl-click your mouse on a mac. A menu will appear where you may choose paste. Alternately, you may use keyboard shortcuts: Use ctrl+c to copy and ctrl+v to paste on both a PC and Mac.

Pasting Text From Word or Email
When you attempt to paste text from an outside application, the text can carry hidden web code. To remove this code as you paste, use the Paste as Plain Text button (see Figure 12, Item 2). This button will ensure that all formatting is removed.

Although this button will eliminate many future problems, it removes all formatting. This means that any bold, italic, underlined, or linked words will appear as plain text. You will need to manually add format options to your text.

Clicking this button will ensure all text is pasted as plain text while you are editing the page. You may use the Paste button (explained above) in conjunction with the Paste as Plain Text button.

Adding a Link
Cascade breaks down links into two categories: Internal links and external links. Regardless of which kind of link you would like to add, start by selecting the appropriate text. You will then notice the add/edit link button will be activated (see Figure 12, Item 3). Click on the add/edit link button to reveal the link window.

Internal Link
An internal link is a link to anything that is on your website. This could be a page, a PDF, or a Word document.

- **Link to a page or document:** To add an internal link, click the brackets next to the Link field. This triggers another window where you are able to navigate to the appropriate page. Once you have located the page to which you wish to link, click the Confirm button.

- **Link to an anchor:** To link to a specific spot on a page, type the anchor name into the Anchor field. You may use this for the page you are currently editing, or a page elsewhere on your site. See the instructions on the following page if you wish to add anchors to your current page. If you wish to add an anchor to another page on your site, first choose the page you will link to (as described above). Then, type the appropriate name into the Anchor field.
External Link
External links are links to any pages that are not on your website. Even if the link is a Northwestern website, it is still considered an external link.

- **Link to a page on another website:** In order to create an external link, you must select the External radio button. Then, type or paste the link to the external website into the Link field. We also recommend changing the Target field from Same Window to New Window. This will ensure the external link opens in a new window, keeping your website available in the background.

- **Link to an email address:** Email addresses are treated as external links. In the Link field, you must erase the http:// prior to adding any email information. After you have cleared the Link field, type mailto: into the field, then type the email address.

*Edit a Link*
Editing a link can sometimes be tricky in any WYSIWYG editor. Cascade makes it simple – simply place your cursor somewhere in the middle of the link. For best results, do not attempt to highlight the text. Simply click the Add/Edit link button. You would then follow the instructions as outlined in *Adding a Link* section.

*Remove a Link*
Removing a link is simple. Place your cursor somewhere in the middle of the link. Then, click the Unlink button (see Figure 12, Item 4). This removes the link from the text.

*Add an Anchor*
An anchor is an invisible bookmark on your page. When pages have a large amount of text, such as an FAQ page, it is easier to break up the page using anchors.

In order to create an anchor, place your cursor wherever you want the invisible marker to be located. Then, click the Insert/Edit Anchor icon (see Figure 12, Item 5). This will open the Insert/Edit Anchor window. Next to the Anchor Name field, type a short name for your anchor. Since this will appear as part of the URL within the address bar, it is important to use a lowercase name without spaces. After you have chosen a name, click the Insert button. You will now see a small anchor image where you have placed your anchor. This anchor image is only visible within Cascade – when you publish your website, this image will not appear on the page.

*Headings*
The Format dropdown box presents you with several different options to appropriately format your text (see Figure 12, Item 6). Any text that does not receive a special treatment is Paragraph text. The majority of the text in your website is formatted as Paragraph text.

*Heading 3-Heading 6* allows you to catch your visitor’s eye when he or she scans the page. *Heading 1* is reserved for your site title; *Heading 2* is always reserved for the page title. Web Comm automatically builds this in for you. You may use *Heading 3-Heading 6* multiple times, if it makes sense to do so. See page 31 for an example of proper heading use.
**Adding an Image**

Prior to adding an image to a page, you should first upload the image (see *Upload an Image or a File* on page 15). Although you may still upload an image from within the WYSIWYG editor, it is far more difficult to make edits to your image.

To insert an image onto your page,

1. Click the **Add/Edit Image** button (see Figure 12, Item 7) and insert the image.
2. Select the image, go to **Format** and format the image using **paragraph**. This will enclose the image in paragraph tags.

**Embedding/Inserting a Video**

The "**Insert/Edit Image**" dialog allows maintaining aspect ratio when modifying dimensions of images. Alternative text now can be left empty if the user checks a box to specify that a given image is a decorative image. Empty "alt" attributes on images are the accessible way to indicate that an image should be ignored by assistive technologies such as screen readers.

- In the "**Insert/Edit Media**" option, you will be able to embed the snippet of HTML insert/embed code directly inside the dialog box.

- YouTube is the most ubiquitous video sharing platform out there and will be the default video type option now, but the editor is flexible enough to handle a wide variety of media type like HTML5 Audio, HTML5 Video and Iframe media types. After you have located the appropriate embed link, copy the whole insert/embed code.

**Example:** Embed Code (from youtube)

```
<iframe width="560" height="315"
src="http://www.youtube.com/embed/8L8UCfxtmSw" frameborder="0"
allowfullscreen></iframe>
```

**Example:** Share Code
(From youtube)

http://youtu.be/8L8UCfxtmSw
**Inserting a Table**

**Note:** Using tables within Cascade requires that you have the right-click enabled on your mouse.

To create a table, place your cursor wherever you wish to place the table. Click the **Insert/edit table** button (see Figure 12, Item 9). The Insert/modify table window will appear. Next to **Cols**, type the number of columns you wish to have in the table. Next to **Rows**, type the number of rows you wish to have in the table. You may add additional columns and rows at a later time if you initially created a table that is too small.

**Edit a Table**

After you create the table, click within each cell to add additional text.

To adhere to best practices, it is a good idea to designate each cell within the top row as a table head. To do this, right-click to reveal the edit table menu. Then, mouse over **Cell** and choose **Table Cell Properties**. This opens the table cell properties window. Next to **Cell type**, change the dropdown to **Header**. Toward the bottom of the window, change the bottom drop-down to **Update all cells in row**. Click the **Update** button to close the table cell properties window and to change all cells in the top row.

To add a new row or column, right-click on the table to reveal the edit table menu. Mouse over either **Row** or **Column**, then click on the appropriate insert option.

See included supplemental guide for more detailed instructions.

**Cleanup Messy Code/Remove Formatting**

Both the **Cleanup messy code** and **Remove formatting** buttons are available for any oddities you may experience after cutting and pasting code. (Many of these issues can be avoided by using the **Paste as Plaintext** button.)

**Cleanup messy code** attempts to remove any extraneous code that may have carried over from another program (see Figure 12, Item 10).

**Remove formatting** will remove any and all formatting, such as bold, italic, or underline (see Figure 12, Item 11).

To use either button, select the appropriate text and click either **Cleanup messy code** or **Remove formatting**. The WYSIWYG editor may not reveal any change, but using these buttons may help you to correct and/or avoid formatting oddities.

**Edit HTML**

If you are comfortable with HTML, you still have the ability to view and edit the code that the WYSIWYG attempts to hide. To view the HTML, click on the **Edit HTML source** (see Figure 12, Item 12). This will open a separate window that contains only HTML code.

**Line Break**

To create a line break (or a new line without a space), simply press shift+enter on your keyboard.
e. **Autosave Drafts**

Drafts now will be saved automatically in the background as the user makes changes in the content. When editing in Cascade, carefully read any new messages regarding drafts.

- You will see a message at the top of the edit window indicating that you are editing a draft of your asset.
- You can preview the current version of the asset or preview the draft by using the viewing options.
- To avoid issues with editing outdated drafts (i.e., drafts of assets that have been edited since the initial draft was created), users now will be directed to current version of the asset when attempting to edit it. When the edit window for the current version is loaded, a link to a draft is presented if a draft already exists.
- Also, when editing a draft that is outdated, a prominent warning will be displayed.
- Draft related confirmation dialogs are now inline pop-ups instead of full-page refreshes, which prevents issues with losing unsaved content when confirmation dialog is displayed.
- Lastly, saving a draft does not perform form validation anymore. This allows saving partially populated forms as drafts without receiving error messages about missing required fields.

f. **Submit**

The submit button marks the page ready for publishing. This means that the page is not yet live, but the changes are submitted into the Cascade server. You must publish the page in order to bring your edits live. Publishing is covered later in this manual.

To submit your changes, scroll to the bottom of the edit screen. Locate and click the **submit** button. This will take you to the view screen and Cascade will notify you that the changes have been submitted successfully.
4. **Add a New Page**  
From time to time you will need to add additional pages to your website. Before adding a page, we recommend locating the appropriate folder within the folder tree. This will ensure that you are in the correct location when the new page is created. If you forget this step, you can change the parent folder later.

To add a new page, locate and click **New** on the tool bar (see **Figure 6**). A menu will appear.

Locate and click the item labeled **Standard Page**. A new page form will appear in the Cascade’s main window.

**Note:** You can exclude your page from publishing and indexing by going to **Edit → System** and unchecking publish and index checkboxes. By doing so, you exclude a page from being published accidently. This is especially important when a site has multiple content editors.

5. **Edit a Page**

   **a. Upload an Image**
   
   Uploading any new image to Cascade will follow the same basic process as creating a new page. The primary difference is where you will place images.

   **Tip:** Name the image an appropriate name before uploading it to Cascade. We recommend names that are lowercase with no spaces.

1. Locate and click the folder where you wish to upload your files. You must place images in the **Photos** folder, but you may select a subfolder if it is appropriate.
2. On Cascade’s tool bar, locate and click **New**. A new menu will appear.
3. Within the menu, click on **Image – JPG, GIF, PNG**. This will open a new file form within the main Cascade window.
4. Click **Browse**. It will open a file window to your computer’s storage. Locate and click on the appropriate image file. Once you have located the correct image, click **Open**.
5. Once you upload the image, an option to edit the image will appear within the main Cascade screen. Please follow image size recommendations that are specific to the page type. To ensure your image is not too large, simply look at the number in the width field.

6. You may either type a smaller number in the width field, or you may crop the image. If you enter the number into the width field, Cascade will change the image length automatically. If you wish to crop the image, simply click and drag over the image. This will create a dashed box. If you did not select the correct area you may continue to adjust the box. When you are ready to crop the image, click the crop selection button.

7. Once you have chosen the correct image or file, scroll to the bottom of the page. Locate and click the Submit button.

8. Once you click submit, you are redirected to the image view screen. You will also see a green confirmation at the top of the screen. When Cascade displays Asset created successfully, it indicates that the image has been successfully uploaded.

b. Upload a File
Uploading any new file to Cascade will follow the same basic process as creating a new page or as creating a new image. The primary difference is where you will place files.

Tip: Name the file appropriately name before uploading it to Cascade. We recommend names that are lowercase with no spaces.

1. Locate and click the folder where you wish to upload your files. We recommend placing documents forms folder (located in the policies-forms folder).


3. Within the menu, click on appropriate file type. This will open a new file form within the main Cascade window.

4. Next to Title, provide an appropriate name for the file.

5. Click Browse. It will open a file window to your computer's storage. Locate and click on the appropriate image file. Once you have located the correct image, click Open.

Tip: Use documents (such as Word Docs and PDFs) sparingly. Documents that contain informational or instructional text should be converted to a web page. If the file contains a form that does not require a signature, contact your site administrator for creating or editing web forms.
c. **Replace an Image or File**

Instead of uploading multiple versions of the same image or file, we recommend using the edit option to simply replace the current file. Using edit is advantageous because you will not have to change any existing images or links.

Editing an image or file is nearly identical to uploading one. To edit a file or image, locate and click the appropriate folder. As previously discussed, images are typically located in the **photos** folder and documents are typically located in the **forms** folder.

1. Locate and click the photo or file you wish to edit. This will display a preview of the image or file (some files will not display) in the main Cascade window.

2. Toward the top of the main window, locate and click **Edit**. The edit screen will load in the main window.

3. If you are editing an image, you may adjust the size or orientation. You may also crop the image at this point. See page 15 for further information about the image editor.

4. Click **Browse**. It will open a file window to your computer’s storage. Locate and click on the appropriate image or file. Click the **Open** button.

5. If you are replacing an image, you may edit the new image in this screen. See page 15 for further information about the image editor.

6. Once you have chosen the correct image or file, scroll to the bottom of the page. Locate and click the **Submit** button.

7. After clicking **Submit**, you are redirected to the image view screen. You will also see a green confirmation at the top of the screen stating **Edit successful.**
d. Create a New Folder
Creating new folders will help to keep information organized within Cascade. It also will provide a clean and comprehensive way for your visitors to navigate your site.

1. To create a new folder, locate and click on the folder where you wish to place the new folder. For example, click on the **images** folder to create a subsection for your images.

2. On Cascade's tool bar, locate and click New (see Figure 11). A new window will appear.

3. Within the menu, click on **Folder**. This will open a new folder form within the main Cascade window.

4. The fields available in the folder form are the same as the page fields. See page 7 for detailed field information.

5. Once you have named the folder, scroll to the bottom of the page. Locate and click the **Submit** button. This will take you to the view screen where a confirmation message will display.

Note: An index file is automatically created when you create a new folder. Be sure to edit the index page. Think of the index page as the new folder's home page.

e. Edit Folder
Editing a folder is similar to editing other items in Cascade. Using the folder tree, locate the folder you wish to edit. In the tabs area, locate and click the **Edit** tab (see Figure 12). Once you are on the edit screen, you will notice that the folder fields are the same as the page fields. See page 7 for detailed field information.
f. **Edit the Footer**

The footer contains important information such as your email address and/or your physical address. Changing the footer information will affect every page on your site.

1. To change the footer information, locate the _common_ folder. Click on the block labeled **footer**.

2. Within the main window, you will see a preview of the footer text. To change this text, click the **Edit** tab at the top of the main Cascade window.

3. Within the information box, you will see a WYSIWYG editor. Edit or add the appropriate information. For more detailed information about WYSIWYG editor, see page 9.

4. Once you have finished editing the footer, scroll to the bottom of the page. Click the **Submit** button to mark your changes ready for publishing.

---

**g. Reorder Left-Hand Navigation**

You may change the order for any second level navigation item. If you wish to change the order of your links, you may do so by viewing the section you wish to change.

---

**Note:** Since the footer effects all pages within your website, you must publish the entire site. See page 20 for further information about publishing.

---

For example, to change the order of the **“About”** folder, click on **about** in the folder tree. This will display the folder contents in the main Cascade window.

1. Click the column labeled **Order**. This places in the order that they appear within the navigation. Even though some items may be hidden, such as pages, folders, or files, those items will still appear within the folder contents. If you are confused about which items currently appear on your website, you may preview the index page within this section.

2. To change the order, move your cursor slightly to the right of the item’s name. Your cursor should turn into an arrow. Click and drag the item to the appropriate location.

3. Another way to move items is to use the arrows under the **Actions** column. The first arrow will move the item to the top of the list. The last arrow will move the item to the bottom of the list. The arrows in the middle will move the item one up or one down.

---

**Warning:** Be aware: changing the navigation marks it ready to publish without a submit button.
h. View Different Versions
Whenever you submit a change, Cascade saves the change as a new version. Additionally, Cascade archives all previously submitted changes (up to 90 versions). This means that any changes made to pages, files, images, or folders are saved. If you ever wish to view or roll back to a previous version, you may do so with the following steps.

1. To view the previous version of any asset, locate and click the appropriate asset. You will then see a list of the previous versions saved within Cascade.
2. Locate and click the version you would like to view. A preview of the previous version is displayed in the main Cascade window.
3. If the version you chose is incorrect, you may navigate either one older or one newer using the links below the tab section. If the version is correct, you may click Activate to mark it ready to publish.
4. After you click Activate, Cascade will create a copy of the old version. This copy becomes the newest version.

i. Publishing/Un-publishing
Publishing is the final step in taking your changes live. Un-publishing an asset removes it from your live website, but a copy will remain on Cascade. You can publish or un-publish in several different ways.

Tip: If you would like to view the publish queue, locate and click the Cascade icon. Mouse over Publisher, and then click Active Jobs. This will show you where your item is in the publish queue.

j. Publish/Un-publish a Single page, File, or Image
It is generally easier to publish or un-publish a single asset, rather than publishing the entire site.

1. To publish/un-publish a page, file, or image, locate the item.
2. Once you are on the view screen, click the Publish tab.
3. A page with test destinations will appear. Leave all items checked to ensure everything publishes to your live site correctly.
4. If you would like to publish the asset, scroll to the bottom of the main Cascade window. Locate and click the Submit button.
5. If you would like to un-publish the asset, locate the field labeled Publish Mode. Change the radio-button toggle to Un-publish. Scroll to the bottom of the main Cascade window. Locate and click the Submit button.
k. Publish/Un-publish an Entire Folder and its Contents
If you add several documents and/or if you change several pages, you may wish to publish an entire folder instead of publishing each individual asset.

a. To publish an entire folder, in addition to its contents, locate the folder you wish to publish.

b. Once you are on folder the view screen, click the Publish tab.

c. A page with test destinations will appear. Leave all items checked to ensure everything publishes to your live site correctly.

d. If you would like to publish the entire folder, scroll to the bottom of the main Cascade window. Locate and click the Submit button.

e. If you would like to un-publish entire folder, locate the field labeled Publish Mode. Change the radio button toggle to Un-publish. Scroll to the bottom of the main Cascade window. Locate and click the Submit button.

1. Publish/Un-publish the Entire Website
When you update a common element, such as your navigation or the footer, you must publish the entire website.

1. To publish the entire site, locate and click the Base Folder in the folder tree.

2. Once you are on the folder view screen, click the Publish tab.

3. A page with test destinations will appear. Leave all items checked to ensure everything publishes to your live site correctly.

4. If you would like to publish the entire site, scroll to the bottom of the main Cascade window. Locate and click the Submit button.

5. If you would like to un-publish entire site, locate the field labeled Publish Mode. Change the radio-button toggle to Un-publish. Scroll to the bottom of the main Cascade window. Locate and click the Submit button.

Warning: When you un-publish, a visitor attempting to view that item will receive a Not Found message. If this is problematic for your organization, you should upload or create an asset using the old asset's name.
6. Moving/Renaming within Cascade
Moving or renaming items is discouraged, but may occasionally be necessary. When you move or rename an item, this means that other sites’ links will break. Additionally, if any visitors have bookmarked this particular page, their bookmarks will no longer work.

Prior to moving or renaming any folder, page, or file, you must un-publish. See the previous topic un-publishing.

a. Moving a Page, Folder, or File
You may move any item within Cascade, with the exception of index pages. We recommend contacting Web Comm prior to moving any index pages to ensure there are no dependent elements that are built into your template.

1. To move an asset, locate and click the appropriate item. Once you are on the view screen, locate and click the Move/Rename tab. The move/rename screen will appear.

2. Next to the field labeled Parent Folder, click on the folder icon. This opens a window that allows you to view folders within your site.

3. In the folder navigation window, locate and click the folder to which you are moving the asset. Click the Confirm button to confirm the appropriate folder and to close the window.

4. Scroll to the bottom of the main Cascade window. Click the Submit button.

5. You are then taken to a folder view screen. A message at the top of the page will state, “Move and Rename successful”, which confirms that the asset has been moved.

b. Rename a Page, Folder, or File
Renaming items in Cascade will change system name. The system name appears within the URL on your website. We recommend never renaming an index page. Every folder should have an index page.

1. To rename an asset, locate and click the appropriate item. From the view screen, locate and click the Move/Rename tab. The move/rename screen will appear.

2. Next to the field labeled System Name, edit the asset’s name. After you have finished editing the system name, scroll to the bottom of the main Cascade window. Click the Submit button.

3. You are then taken to a folder view screen. A message at the top of the page will state, “Move and Rename successful”, which confirms that the asset has been renamed.
c. Deleting a Page, Folder, or File

Similar to moving or renaming items, you may delete any item within Cascade, with the exception of index pages. We recommend contacting Web Comm prior to deleting any index pages to ensure there are no dependent elements that are built into your template.

Deleting items is discouraged, but may occasionally be necessary. When you delete an item, this means that other sites’ links will break. Additionally, if any visitors have bookmarked this particular page, their bookmarks will no longer work.

1. To delete a page, folder, or file, locate and click the appropriate item. From the view screen, locate and click the More tab. This will reveal another menu. Locate and click the Delete option.

2. On the delete screen, Cascade provides a warning message. Beneath the warning message, locate and check the Un-publish Content box.

3. If any assets link to this item, a Relationships box will appear. If you see this box, we suggest contacting Web Comm prior to deleting the item.

4. When you are certain you wish to remove the item, scroll to the bottom of the main Cascade window. Locate and click the Submit button. Once you click submit, you are taken to the base folder’s view screen. A green “Delete Successful” message will appear at the top of the screen. This confirms that the item was removed from both Cascade and your live website.
A. Step-by-Step Quick Reference

No time to read the entire manual? Keep this guide by your desk for future reference.

1. Log into Cascade
   a. Go to http://www.northwestern.edu/cms.
   b. Click on Cascade Server Login.
   c. Enter your NetID and Password. Click the Log In button.
   d. Change the dropdown from Global to WCAS-(YourSite).

2. Edit a Page
   a. Use the folder tree on the left-hand column to locate the appropriate page.
   b. In either the left-hand column or the default cascade window, click the page you wish to edit.
   c. Toward the top of the page, locate and click the Edit tab.
   d. Edit the page accordingly. See below for further explanation about specific fields, or see page 9 for instructions on how to use the WYSIWYG editor.
   e. Once you have finished editing, click the Submit button on the bottom of the screen. You are then taken to a page view screen. This will display a green confirmation message notifying you that the page was successfully saved.

3. Add a New Page
   a. Using the folder tree, locate and click the folder where you would like to create a new page.
   b. Click New from the Cascade tool bar. A drop down menu will appear.
   c. Choose Page from the drop down menu. A new page form will load in the main system window.
   d. *Optional - Next to Display Name, type a short descriptive name for the page. The display name will appear in any navigation elements (such as the left-hand navigation or the breadcrumbs) once the page is published.
   e. Within the Title field, type an appropriate page name. The title will appear on the top of the browser and at the top of the content once it is published. Additionally, if no display name has been entered, all navigation elements will use the title instead.
   f. Next to Left Menu choose Yes if you would like the page to appear in the navigation. Choose No if the page should not appear in the navigation.
   g. Fill in the Page Content field with the text you would like to display on the page. See Using the WYSIWYG Editor on page 9 for more information.
   h. Fill in the Left Column field with the text you would like to display on the left-hand column.
   i. Once you have finished adding the information for the new page, click the Submit button on the bottom of the screen. You are then taken to a page view screen. This will display a Green confirmation message notifying you that the page was successfully saved.
4. **Upload an Image or a File**

A file can be a Word Document (doc), a PDF, or an image (such as jpg or gif).

a. Using the folder tree, locate and click the folder where you would like to upload a new file.
b. Click **New** from the Cascade tool bar. A drop down menu will appear.
c. In the drop down menu, click **File – JPG, PDF, Doc, etc.** A new file form will load in the main system window.
d. To upload your file click the **Browse** button. This will open a file window on your computer so that you may locate the correct file.
e. Select the appropriate file.
f. Once you have selected the new file, click the **Submit** button on the bottom of the screen. You are then taken to a file view screen. This will display a green confirmation message notifying you that the file was successfully uploaded.

5. **Create a new folder**

a. Using the folder tree, locate and click the folder where you would like to create a new folder. If you would like to create the folder in the main area of your site, simply click **Base Folder**.
b. Click **New** from the Cascade tool bar. A drop down menu will appear.
c. In the drop down menu, click **Folder**. A new folder form will load in the main system window.
d. *Optional - Next to **Display Name**, type a short descriptive name for the folder. This will appear in any navigation elements (the left-hand navigation or the breadcrumbs) once the page is published.
e. Within the **Title** field, type an appropriate file name. If no display name has been entered, all navigation elements will use the title instead.
f. Next to **Display in Navigation?** choose **Yes** if you would like the folder to appear in the navigation (if it will hold pages). Choose **No** if the folder should not appear in the navigation (if it will hold files).
g. Once you have finished adding the information for the new folder, click the **Submit** button on the bottom of the screen. You are then taken to a folder view screen. This will display a green confirmation message notifying you that the asset was successfully saved.

---

**Tip:** Remember, after you have added the new file in Cascade, you must add a link to the file or you need to insert the image onto the page. Step-by-step instructions are available on page 28 or 29, respectively.

---

**Note:** When you add a new folder, a new index page is automatically created within the folder. If you choose to display the folder in the navigation, you must edit the index page.
6. **Reorder Navigation**
   a. Using the folder tree, locate and click the folder where you would like to change the navigation.
   b. Within the main system window, click the **order** heading. This will arrange the assets by their navigation order.
   c. On the item you wish to move, point your mouse slightly to the right of the asset’s name. Click and hold to select the item.
   d. Drag the asset to where you would like it to appear on the navigation.
   e. Repeat steps 3 and 4 until you have changed the order to your liking.
   f. Follow the instructions on page 27 to publish the entire site. This will update the navigation on your live site.

7. **Edit the Footer**
   a. In the folder tree, locate and click the folder labeled **_common**, then click **Footer**.
   b. Within the main system window, click the **Edit** tab. The edit form will appear.
   c. Make the edits to the footer as appropriate. For further information on the WYSIWYG field, see page 27.
   d. Once you have finished editing the footer information, click the **Submit** button on the bottom of the screen. You are then taken to the page view screen. This will display a green confirmation message notifying you that the edit was successful.

8. **Publish/Un-publish a Single Page, File or Image**
   a. Using the folder tree, open the page you wish to publish.
   b. Locate and click the **Publish** tab.
   c. Ensure the **Live Site** option is checked under the Destination heading.
   d. **To publish**, ensure the radio button next to **Publish Mode** indicates that **Publish** is selected.
      **To un-publish**, change the radio button next to **Publish Mode** to select **Un-Publish**.
   e. Click **Submit** to publish the page.
9. Publish/Un-publish an Entire Folder and its Contents
   a. Using the folder tree, open the folder you wish publish.
   b. Locate and click the Publish tab.
   c. Ensure the Live Site option is checked under the Destination heading.
   d. **To publish, ensure the radio button next to Publish Mode indicates that Publish is selected.
**To un-publish, change the radio button next to Publish Mode to select Un-Publish.
   e. Click Submit to publish the page.

10. Publish/Un-publish the entire website
   a. Using the folder tree, click on the base folder.
   b. Locate and click the Publish tab.
   c. Ensure the Live Site option is checked under the Destination heading.
   d. **To publish, ensure the radio button next to Publish Mode indicates that Publish is selected.
**To un-publish, change the radio button next to Publish Mode to select Un-Publish.
   e. Click Submit to publish the page.

11. WYSIWYG Editor

Heads resemble newspaper headlines – heading 1 is reserved for your site title and heading 2 is reserved for your page title and headers. You may use Heading 3-Heading 6 multiple times, throughout the content to highlight important titles.

a. Change text into a heading
   1. Highlight the text you wish to change.
   2. In the Format dropdown menu, click the arrow to reveal the heading styles.
   3. Click the heading type you wish to use. You can see a sample of heading styles in Figure 13. The text will change immediately to reflect the heading you have chosen.
b. **Creating a List**
   1. Place your cursor next to the text you wish to turn into a list.
   2. Press the unordered list button to create a bulleted list or press the ordered list button to create a numbered list.

c. **Adding a Link to an Internal Page**
   1. Highlight the text you wish to turn into a link.
   2. Locate and click the link button. A new window will appear.
   3. The internal link is chosen by default. Next to the Link field, click [ ] to open a new window.
   4. In the popup window, use the folder tree to locate the appropriate page. Click on the page name to select it.
   5. Click the **Confirm** button to verify that you have chosen the correct page. This will close the popup window.
   6. Click the **Insert** button to insert a link to the page of your choice. This will add your internal link.

d. **Add a Link to a File (pdf, doc, etc.) on Your Site**
   1. Highlight the text you wish to turn into a link.
   2. Locate and click the link button. A new window will appear.
   3. The internal link is chosen by default. Next to the Link field, click [ ] to open a new window.
   4. In the popup window, use the folder tree to locate the appropriate file. Click on the file name to select it.
   5. Click the **Confirm** button to verify the file is correct. This closes the popup window.
   6. Click the **Insert** button to insert a link to the page of your choice. This adds the internal link.

e. **Add a Link to an Anchor (a Targeted Spot) on the Page**
   1. Highlight the text you wish to turn into a link.
   2. Locate and click the link button. A new window will appear.
   3. The internal link is chosen by default. Next to the Anchor field, type the name of the anchor.
   4. Click the **Insert** button to insert a link to the page of your choice. This will add your internal link.

f. **Add an External Link**
   1. Highlight the text you wish to turn into a link.
   2. Locate and click the link button. A new window will appear.
   3. The internal link is chosen by default. Click the radio button next to **External**.
4. In the **Link** field, type (or paste) the address to the page. Be sure to include `http://` for the link will work properly.

5. Click the **Insert** button to insert a link to the external page.

**g. Add an Email Link**
1. Highlight the text you wish to turn into a link.
2. Locate and click the link button. A new window will appear.
3. The internal link is chosen by default. Click the radio button next to **External**.
4. In the **Link** field, type `mailto:` and then type the email address. For example: `mailto:sample@northwestern.edu`
5. Click the **Insert** button to insert a link to the external page.

**h. Add an Image**
1. Place your cursor in the space where you wish to insert an image.
2. Click the image button. A new window will appear.
3. Next to the **Image** field, click `[ ]` to open a new window.
4. In the popup window, use the folder tree to locate the appropriate image. Click on the file name to select it.
5. Click the **Confirm** button to verify that you have chosen the correct image. This will close the popup window.
6. *Optional: If you would like the text to wrap around the image:
   a. Click the **Advanced** tab.
   b. Change the **Alignment** dropdown to select either **right** or **left**.
7. Click the **Insert** button to insert a link to the page of your choice. This will add your internal link.

**i. Add an Anchor**
1. Place your cursor in the space where you wish to create an anchor.
2. Click the anchor button. A new window will appear.
3. Next to the **Anchor Name** field, type in a name for your new anchor. When you link to the anchor, the name is a part of the URL. For this reason, we recommend using lowercase names without spaces.
4. Click the **Insert** button. This will close the window and insert the anchor into the page.

**j. Add a Table**
1. Place your cursor in the space where you wish to create a table
3. Next to the field labeled **Cols**, type the number of columns your table will hold (the default is 2).
4. Next to the field labeled **Rows**, type the number of rows your table will hold (the default is 2).

5. Next to class, choose the appropriate style for your table. See page 27, for an example of each style.

6. Click the **Insert** button. This will close the window and insert your new table.

7. Select the first row in your table. Right-click on the table to reveal the table menu.

8. Mouse-over **Cell**, then click on **Table Cell Properties**. A new window will appear.

9. Within the **Cell Type** field, change the drop-down menu to **Header**.

10. Click **Update** to close the window. You may now begin typing information into your new table.

**k. Edit a Table**

- **Add a New Row**
  1. Place your cursor either above or below of where you wish to place the new row.
  2. Right-click to reveal the edit table menu.
  3. Mouse-over **Row**, then select either **Insert Row Before** or **Insert Row After**. This closes the table menu and adds a new row.

- **Add a New Column**
  1. Place your cursor either to the right or left of where you wish to place the new column.
  2. Right-click to reveal the edit table menu.
  3. Mouse-over **Column**, then select either **Insert Column Before** or **Insert Column After**. This closes the table menu and adds a new column.
B. Best Practices for Web Writing

Strategies for effective online communication:

- **Write for non-readers**
  Make content easy to scan. Write short paragraphs with the most important information at the top of the page. Use formatting options like subheadings to give readers quick answers and bulleted/numbered lists to slow readers down. Trim the fat in your writing with simple sentences and active verbs.

- **Write in a direct, personal tone**
  The web is an immediate and informal medium, so the tone should be active and personal. Use the imperative (commanding) voice and first- or second person pronouns. (Ex: “Find a job.” “Enter your personal information.”)

- **Write for your audience (not your boss)**
  Although official language is sometimes necessary, try to avoid institutional language, marketing jargon and items that are meaningful for your office but not your users (such as mission statements).

- **Write for search engines**
  Get high rankings in Internet searches by using the key terms in your content. Consider your word choice carefully, using generic words rather than jargon (ID card, not WildCARD), and writing out acronyms.

- **Remove ROT**
  Prune your site of unnecessary content by removing redundant, outdated or trivial content. Look out for multiple versions of pages, old content that may not be current, or pages with very little content.

- **Make targets visible**
  Help users accomplish their tasks by making key information prominent and easy to find. Ask yourself why visitors are coming to the page, and what information is the most critical.

- **Make links obvious**
  Linking is the way people move around your site. Facilitate this movement with clear links. The link text should be descriptive (yet brief), the link itself should be distinguishable from the rest of the content, and PDFs should be clearly indicated.

- **Know your user**
  Keep users at the forefront of your mind when writing. What do they need, and what do they know about the topic? Verify your assumptions through user feedback, traffic analysis and usability testing.
C. Best Practices for Headers

Heading 1 is reserved for your site title and heading 2 is reserved for your page title and headers. You may use **Heading 3-Heading 6** multiple times, throughout the content to highlight important titles. The remaining headings should be used throughout the content to highlight important titles.

Avoid using a header in the main content area just to change the font type, size, or color. Although Web Comm has defined this in the design phase, business needs arise beyond the design’s initial scope. If you would like to discuss a special font style to meet this need, contact your site admin for further assistance.

**Note:** Always use headers in numerical order. Doing so will ensure you achieve Search Engine Optimization (SEO) as well as Accessibility.
D. Best Practices for Accessibility

1. Alternative (Alt) Text
   a. Used to describe images or other non-text items on page
   b. Questions to ask:
      - Why is non-text content on page?
      - What information is it presenting?
      - What purpose does it fulfill?
      - Can I use text instead of image?
      - Is the non-text content necessary?

2. Tables
   a. For screen readers, a header row is required; header columns preferred
   b. Summaries are also required; similar to alt-text for an image

3. Links
   a. Avoid links that say only “visit” or “click here”
   b. When linking to a file, include the file type (PDF, DOC, XLS, ZIP, etc.) as part of the link either as text in parentheses or as an icon with appropriate alt-text
   c. Link to a File (PDF) instead of Link to a File (PDF)

4. Word Docs
   a. Heading should be structured
   b. Alt-text for images, tables, and descriptive links

5. Audio and Video
   a. Audio-only content should include a text transcript
   b. Video content with audio should include a transcript at minimum (simultaneous captioning preferred)
   c. Also applies to animation and live events
E. Working with Tables

Working with tables in Cascade can sometimes be tricky. This document explains how to edit tables through the regular Cascade WYSIWYG editing interface. Before you insert a table in Cascade, we recommend that you create a mock up of the table in notepad. Knowing how many rows and columns your table will save you a lot of editing time.

1. Table Properties
   a. General Tab
      • **Cols** - The total number of columns in your table.
      • **Rows** - The total number of rows in your table.
      • **Cellpadding** - Describes the amount of space (in pixels) between the text and the edges of each cell.
      • **Cellspacing** - Refers to the amount of space (in pixels) between cells.
      • **Alignment** - Refers to the placement of the table within the page.
      • **Border** - Refers to lines separating your cells and how thick those lines are.
      • **Width** - Describes the width of your table on the page.

   b. Advanced tab
      **Summary:** Explaining the purpose of the table (for accessibility).

2. Inserting a Table

   **Insert a table:**
   1. While in the **WYSIWYG**, select the location for the image
   2. Select the table icon
   3. Enter number of columns and rows
   4. Select "**Align Top**" from the Alignment drop down box
   5. Select the **Class** - These classes have been created to work with Northwestern University templates.
   6. Select Insert

3. Modifying a Table

   1. Right click anywhere in the table
   2. Table options appear which allow deleting, adding, and accessing table properties.
4. Border Table Class

Modify a table to have a “table-border” class:

1. Insert table – See above
2. Click in the first cell of the row to darken
3. Right-click, select Row, Table row properties
4. Select the ‘table-border’ as table border class
5. Select Insert
6. Repeat steps for each row to darken.

5. Table Headings

To define table headings, you need to define table cells (usually a title row or a title column) as table heading cells (<th> – an individual cell that will hold a row or column title). In Cascade Server, you can apply heading cell definitions to several table cells at once.

1. Click in a head of the row or column where you would like your headings to appear. Then, right-click and choose Cell » Table cell properties.
2. In the Table cell properties dialogue window, click the drop-down menu labeled Cell type and then choose Header:
3. Just above the Update button, you will see an unlabeled drop-down menu. Click that drop-down menu and select Update all cells in row:
4. Click the Update button to finish adding table headings:
5. On occasion, you may need to use merged cells. A merged cell is a cell that spans 2 or more rows and/or columns. This example demonstrates how to merge two adjacent cells in two different rows. To begin, select the adjacent cells that you want to merge. Then, right-click in one of the selected cells and choose Cell » Merge table cells:
6. When you finish editing a table, click the Submit button at the bottom of the editor window to save your changes:

6. Tables and Accessibility

We recommend that you add a table summary to all tables in order to comply with accessibility standards. People with impaired vision who use screen reading software will not be able to detect the structure of a table without added a table summary. A table summary gives a brief explanation of a table and what it contains. Please see Section 508 of the Rehabilitation Act of 1973 and Web Content Accessibility Guidelines (WCAG) for more information.